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Abstract This is a technical documentation of the procedure to run the Weather Research and Forecasting
(WRF) Model over complex alpine terrain using Consortium for Small-Scale Modeling (COSMO) reanalysis
by the Federal Office of Meteorology and Climatology (MeteoSwiss) as initial and boundary conditions
(COMSO-WRF). The setup is adapted for very-high resolution simulations based on COSMO-2 (2.2 km
resolution) reanalysis. This document gives an overview over steps to setup COSMO-WRF and adaptations
needed to run COSMO-WRF. Additionally, the calculation of precipitation rate at a horizontal plane and
remapping of COSMO–WRF output on Swiss Coordinates are documented.
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Introduction

To run the atmospheric model Weather Research and Forecasting (WRF) model version 3.7.1 (Skamarock
et al., 2008) over complex alpine terrain using Consortium for Small-Scale Modeling (COSMO-2) reanalysis (2.2 km resolution) by the Federal Office of Meteorology and Climatology (MeteoSwiss) as initial and
boundary conditions, numerous adaptations are needed. Several pre-preprocessing steps are required to get
the data ready for standard WRF pre-processing. Here, we provide a description of these steps and illustrate
the WRF setup presented in Gerber et al. (2018). Information in boxes is additional information, which may
be specifically for a certain software or system or is not necessarily needed to run a WRF simulation, but
may be of interest. Some parts of the description are specifically for retrieving COSMO-2 reanalysis and the
setup of WRF on Piz Daint on the Swiss National Supercomputing Center (CSCS) and are likely different for
different computing systems. COSMO-2 reanalysis data is available on Piz Daint. MeteoSwiss has to be contacted for permission and access. A list of software, scripts, files and data, needed to get through the whole
procedure, is given in Appendix A.1. Users who have not worked with WRF before are strongly encouraged
to work through the WRF online tutorial (http://www2.mmm.ucar.edu/wrf/OnLineTutorial/index.htm, accessed 20 November 2017) to familiarize themselves with the WRF model. Prior to performing the standard
WRF procedure, several additional steps are needed to run COSMO-WRF over complex terrain, which will
be described in Sections 2 and 3, commenting on pre-preprocessing steps for meteorological data and static
data, respectively. Section 4 gives information about installing WRF and the WRF pre-processing system
(WPS). Information about adaptations and recommended settings for WPS and WRF are given in Sections 5
and 6, while Section 7 gives some information on post-processing procedures.
Note
This document is intended as a guideline. It does not claim to be complete. No responsibility will
be taken in case of damage or loss of any kind.
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Meteorological data
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Meteorological data

COSMO-2 reanalysis are given on a rotated coordinate system, which is not readable by the WRF preprocessing system (WPS). Therefore, COSMO-2 data needs to be regridded to regular latitude-longitude
coordinates. Additionally, several grib parameters need to be changed to make COSMO-2 input readable by
WPS. The rotation is performed using the program fieldextra by MeteoSwiss, which is available on the
CSCS computing system.
Location fieldextra: /users/oprusers/osm/opr/abs/fieldextra (location may change)
Location COSMO-2 files: /store/archive/mch/msopr/owm/COSMO/LA<YEAR>/<DATE>.tar
Note
Fieldextra is a licensed software which belongs to MeteoSwiss and is the official COSMO postprocessing software. Free license may be granted to R&D institutions, but without support; if you
are interested contact MeteoSwiss. Additionally, COSMO–2 reanalysis belong to MeteoSwiss and
to access and use the data MeteoSwiss must be asked for permission.

2.1

Get COSMO-2 files

Download .tar files for chosen dates.
Run ./cosmo_untar.sh
Note
All COSMO output is given in UTC (Daniel Leuenberger, MeteoSwiss, 21 August 2017, per email).

2.2

Run fieldextra

Basic instruction about the use of fieldextra was provided by A. Iriza and R. Dumitrache from Meteo Romania (personal communication), who previously implemented a COSMO-WRF version to assess
the accuracy of high resolution WRF simulations (Iriza et al., 2016). Advice about namelist setting was
further provided by G. de Morsier from MeteoSwiss (personal communication). In fieldextra surface (2dimensional) and atmospheric (3-dimensional) data need to be processed separately. The domain, variables,
vertical levels, format, in- and output folder for the transformation are specified in the namelists 2Ddata.nl
and 3Ddata.nl.
In 2Ddata.nl and 3Ddata.nl:
• in_file = ’<path_to_input_files>’
• out_file = ’<path_for_output_files>’
• out_regrid_target = ’getlatlon, 4000000, 43000000, 12000000, 49000000, 20000,
20000’, specifies the domain, which is processed ’getlatlon, llon, llat, rlon, ulat,
gridx, gridy’, with llon and rlon the left and right longitude, llat and ulat the lower and
upper latitude, and gridx and gridy the cellsize in x- and y-direction, respectively.
• Specify variables to be read and vertical levels, to which they should be interpolated (see example in
2Ddata.nl and 3Ddata.nl).
For a single day:
> / users / oprusers /osm/opr/abs/ fieldextra 3 Ddata .nl # for 3D data
> / users / oprusers /osm/opr/abs/ fieldextra 2 Ddata .nl # for surface data
Note
When paths change, all paths and lines 45-48 in 3Ddata.nl need to be adapted (analogously for
2Ddata.nl).
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For a series of days:
• Adapt create_list.sh and rot_vel_from_raw_for_WRFinput.py (runs over 24h for all given
dates)
• run the script
> python rot_vel_from_raw_for_WRFinput .py
or submit batch job (on CSCS):
> sbatch rot_vel_from_raw_for_WRFinput .job
• Additionally adapt and run 2Ddata.nl for surface data:
> / users / oprusers /osm/opr/abs/ fieldextra 2 Ddata .nl
Create netcdf from COSMO grib
Adapt output format in 3Ddata.nl and 2Ddata.nl and run fieldextra.
out_type = ’NETCDF ’
out_file = ’<outfile_path_and_name >.nc ’

2.3

Change grib parameters

The following grib parameters (indicatorofParameter) have to be changed for WPS, as COSMO and
WRF use different conventions for grib codes.
Mixing ratio
• Ice mixing ratio (QI): 33 → 178 (because U has also GRIB code 33)
Calling
> ./ change_vals_day .bash <DATE >
changes mixing ratio values for each hour of the specified <DATE>, which has the format YYYYMMDD.
Soil parameters

The following soil parameters need to be adapted:

• Soil temperature (T_SO): 197 → 85
• Soil moisture (W_SO): 198 → 86
Additionally, indicatorOfTypeOfLevel and the levels of the soil parameters need to be adapted
(Table 1). Calling
./ change_vals_day_soil .bash <DATE >
changes soil values for each hour of the specified day, where <DATE> has the format YYYYMMDD.
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Geographical/static data

To run WRF on very-high resolutions (up to 50 meters) over very steep and complex terrain, high-resolution
static data (topography, landuse, soiltype) is necessary. The WRF package provides only static data up to a
resolution of 2 arc min. Here, we use topographic data with a resolution of 1 arc sec (∼30 m). Additionally,
landuse data and soil type data are pre-preprocessed for the same resolution. Before the data can be used by
WPS it needs to be translated to the binary format readable by WPS.
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Table 1: Transformation of soil levels from COSMO to WRF.

COSMO
top
bottom
1
2
6
18
54
162
486
1458

3.1

1
2
6
18
54
162
486
1458

top

WRF
bottom

0
1
3
9
27
81
243
729

1
3
9
27
81
243
729
2187

→
→
→
→
→
→
→
→
→

Topography

The topography is retrieved from the Aster 1 s digital elevation model (METI/NASA, 2009). To get a smooth
transition between the COSMO topography and the WRF topography, a transitional topography is generated
at the edges of the WRF domain. This is important to prevent strong boundary effects, which eventually
cause instabilities in the simulations.
Note
There are even higher resolution digital elevation models available for Switzerland. However, they do
not cover the whole domain of the parent domain of our simulation setup We did not use the higher
quality topography for the inner domains, to avoid inconsistencies of topography at the boundaries of
the nests. However, as strong smoothing (see Section 5.1) is applied during the WRF preprocessing,
we would most likely not benefit much from the higher quality digital elevation model.
• Download 1s resolution topography: https://gdex.cr.usgs.gov/gdex/ (accessed: 18 August 2017).
Dataset: ASTER Global DEM V2 (https://lpdaac.usgs.gov/node/1079, accessed: 15 November 2017,
METI/NASA, 2009)
• Extract a slightly larger domain than the parent domain in ArcGIS and save it as ascii-file.
The domain extracted from the digital elevation model should be slightly larger to make sure the
whole domain, which will be simulated, is inside the extracted digital elevation model. The domain
extracted for the simulations in Gerber et al. (2018) was about 0.1° larger in each direction. As the
coordinates of COSMO-2 all end with an equal number at the second decimal place, the domain has
to be chosen such that its boundaries are at coordinates ending with an equal number at the second
decimal place (e.g. 46.00, 64.02, 64.04, etc., and 9.86, 9.88, 9.90, etc.).
Note
When smoothing the boundaries (see next step) the outermost grid points are set to COSMO topography. This range should approximately cover the excess part of the extracted digital elevation model
(e.g. ∼0.1°).
Steps for extraction of topographic data in ESRI ArcGIS
In ArcCatalogue:
• Create new polygon (specify coordinates, e.g. WGS84 coordinates for Aster topography)
In ArcMap:
•
•
•
•

Open Map
Add digital elevation model (e.g. Aster 1 s resolution)
Add polygon
Draw polygon: Start editing → choose polygon → draw the approximate polygon → save
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Figure 1: Illustration of boundary smoothing. Dark grey shows the boundary, which is changed to COSMO topography.
Light grey shows the transitional zone, which changes by a linear interpolation from COSMO to the high resolution
topography. imax and cosmotopopts are the variables in toposmoothtest_wgs_84_cosmobound.ncl specifying
the boundaries.

• Move edges to chosen position/coordinates:
–
–
–
–

use ’Edit Tool’
double click on polygon → right click on edge → Move to . . .
specify coordinate → Enter
Save & stop editing

• Extract domain from digital elevation model:
– Arc Toolbox → Spatial Analyst Tools → Extraction → Extract by mask
• Save as Ascii:
– Arc Toolbox → Conversion Tools → From Raster → Raster to Ascii
• Run boundary smoothing to adapt topography boundaries of the extracted e.g. Aster topography to
COSMO topography.
To run the boundary smoothing (toposmoothtest_wgs_84_cosmobound.ncl), one COSMO file
in .nc format is required (see box in Section 2.2). The date does not matter, as only the static
(topographic) information is needed. toposmoothtest_wgs_84_cosmobound.ncl is converting
topography at the boundary of the domain to COSMO topography. A transitional topography zone
between COSMO and Aster topography is additionally added (Figure 1). The width of the two zones
can be chosen by the user. For the domain used in Gerber et al. (2018) (using Aster topography
with a resolution of 1 arc second) a COSMO topography boundary of 0.1° (360 grid points) and a
transitional boundary of 0.3° (∼30 km, 1080 grid points) are used. Depending on the domain and the
complexity of the topography these boundaries may need to be adapted.
Adapt the file toposmoothtest_wgs84_cosmobound.ncl:
– Choose input and output directories
– Choose the domain: y1,y2 = min./max. latitude, x1,x2 = min./max. longitude
– Choose number of grid points for COSMO-topogaphy: cosmotopopts (row 17). This should
approximately cover the area, which will be outside of the model domain.
– Choose number of grid point for the COSMO-topography and transitional topography: imax
(row 18)
→ Output will be written to: outputdirectory+’/WRFmatrix_0.txt’
• Create binary file and adapt index file.
Run ascii_to_bin_topo_wgs84_ws2sf1.f90 to create the binary file needed by WPS (adapt
folder and file name in row 23):
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> gfortran -o ascii_to_bin_topo_wgs84_ws2sf1 .exe
ascii_to_bin_topo_wgs84_ws2sf1 .f90 write_geogrid .o
> ./ ascii_to_bin_topo_wgs84_ws2sf1 .exe
This generates the binary file 00001-XXXXX.00001-YYYYY, where XXXXX is the number of grid
points in x-direction and YYYYY is the number of grid points in y-direction. Copy the binary file to
topo_RES (RES gives the resolution of the data) folder in your geog folder.
Adapt the index file (see example file index_topo) in /geog/topo_RES/ folder. When chosing
topography from Aster with 1 s resolution the values known_lat, known_lon, tile_x and tile_y
have to be adapted. For the known_lat, known_lon, tile_x, and tile_y the total contained domain
has to be specified, i.e. the domain including the extra 0.1°.

3.2

Landuse

High resolution landuse data is retrieved from the Coordination of Information on the Environment (Corine)
dataset (European Environmental Agency, 2006). Corine landuse categories cannot be read by WPS
directly. Thus, we did a transfomation of Corine landuse categories to United States Geological Survey
(USGS) landuse categories. Furthermore, Corine landuse is projected to the Aster grid.
• Download Corine landuse data: https://www.eea.europa.eu/data-and-maps/data/clc-2006-raster (downloaded: 15 June 2016, accessed: 18 August 2016, new version available)
• Reclassify Corine categories to USGS categories and remap on chosen resolution and project on
WGS84.
For this step, we follow the description by Arnold et al. (2010) provided on http://forum.wrfforum.
com/viewtopic.php?f=22&t=2266 (accessed: 18.8.2017), which is based on the reclassification from
Corine to USGS landuse categories by Pineda et al. (2004). As Pineda et al. (2004) defines USGS
landuse categories between 101 and 124 an additional conversion (subtraction of 100) is needed for
landuse categories to fit WRF requirements, which defines USGS landuse categories between 1 and
24. Furthermore, the data needs to be remapped on the chosen resolution if the resolution of the
digital elevation model is different from the resolution of the Corine landuse data (additional step to
description by Arnold et al., 2010) and finally needs to be projected to WGS84 coordinates.
Steps for transformation and extraction of Corine data (adapted from Arnold et al., 2010),
ESRI ArcGIS
In ArcMap:
• Open Map (document, which was produced while processing the digital elevation model)
• Add landuse data
• Remap:
– ArcToolbox → Spatial Analyst Tools → Reclass → Reclassify (or any of the other Reclass
tools, based on Pineda et al. (2004), subtracting 100 for each category.)
• Resample:
– ArcToolbox → Data Management Tools → Raster → Raster Processing → Resample:
Choose cell size of digitial elevation model; choose nearest neighbor interpolation
• Reproject to WGS84 coordinates:
– ArcToolbox → Data Management Tools → Projections and Transformations → Raster
→ Project Raster
• Extract domain (same as for digital elevation model) from landuse data:
– Arc Toolbox → Spatial Analyst Tools → Extraction →Extract by mask
• Save as Ascii:
– Arc Toolbox → Conversion Tools → From Raster → Raster to ASCII
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• Create binary file and adapt index file.
Run ascii_to_bin_landuse.f90 to create the binary file needed by WPS (adapt folder and file
name in row 23):
> gfortran -o ascii_to_bin_landuse .exe ascii_to_bin_landuse .f90
write_geogrid .o
> ./ ascii_to_bin_landuse .exe
This generates the binary file 00001-XXXXX.00001-YYYYY, where XXXXX is the number of grid
points in x-direction and YYYYY is the number of grid points in y-direction. Copy the binary file to
landuse_RES (RES gives the resolution of the data) folder in your geog folder.
Adapt the index file (see example file index_landuse) in /geog/landuse_RES/ folder. When
chosing topography from Aster with 1s resolution the values known_lat, known_lon, tile_x and
tile_y have to be adapted. For the known_lat, known_lon, tile_x and tile_y the total contained
domain has to be specified, i.e. the domain including the extra 0.1°.

3.3

Soil type

Keeping the model simple, we only use one soil type (silty clay loam) for the whole domain. This is not
exactly accurate but as we are mainly simulating over a snow cover, the soil type should not make a strong
difference for our simulations. The same file is used for the top and bottom layer soil, which are distinguished
in WRF (SOIL_TOP and SOIL_BOT).
• Create soil type file for whole domain.
Run the script soiltype_writing.py to create a soiltype file consisting of silty clay loam (category
8) or any other chosen category (to be changed in row 42) for the whole domain on the resolution of
the topography data. Adapt the input and output file names and folders (rows 12 and 29).
• Create binary file and adapt index file.
Run ascii_to_bin_soiltype.f90 to create the binary file needed by WPS (adapt folder and file
name in row 23):
> gfortran -o ascii_to_bin_soiltype .exe ascii_to_bin_soiltype .f90
write_geogrid .o
> ./ ascii_to_bin_soiltype .exe
This generates the binary file 00001-XXXXX.00001-YYYYY, where XXXXX is the number of grid
points in x-direction and YYYYY is the number of grid points in y-direction. Copy the binary file to
soiltype_bot_RES and soiltype_top_RES (RES gives the resolution of the data) folder in your
geog folder.
Adapt the index file (see example file index_soiltype) in /geog/soiltype_bot_RES/ and /geog
/soiltype_top_RES/ folders. When chosing topography from Aster with 1 s resolution the values
known_lat, known_lon, tile_x and tile_y have to be adapted. For the known_lat, known_lon,
tile_x and tile_y the total contained domain has to be specified, i.e. the domain including the extra
0.1°.

Installation of WRF and WPS
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Installation of WRF and WPS

Generally, WRF and WPS are installed following the instruction given by the WRF tutorial: http:
//www2.mmm.ucar.edu/wrf/OnLineTutorial/ (accessed: 18 August 2017). However, to make WPS run
with COSMO input some adaptations are necessary.
Compiling WRF:
1. ./configure – choose the distributed memory (dmpar) option for INTEL compiler: INTEL (ftn/
icc): CRAY XC option (the exact option number varies with WRF version)
2. ./compile -j 8 em_real
Note
WPS is compiled after compilation of WRF. Before compiling WPS, it is critical that the changes
suggested in Section 4.1 are implemented. Compile WPS using the INTEL compiler - but only in
serial mode!
Setup environment to install WRF and WPS on Piz Daint CSCS
WRF and WPS were compiled using INTEL compilers provided by the CSCS Programming Environment
The following steps were carried out by modifying the ~/.bashrc script:
1. Change the programming environment from Cray to Intel (module switch PrgEnv-cray
/6.0.4 PrgEnv-intel)
2. Load the netcdf module (module load cray-netcdf)
3. Set path for the netcdf library specific for the compiler (INTEL) used: (export NETCDF=/
opt/cray/pe/netcdf/4.4.1.1.3/INTEL/16.0/)

4.1

Adaptations for WPS

./ungrib/src/rrpr.f90
• Add lines to specify soil moisture and soil temperature variables
• Convert soil moisture values to the unit of WRF (m−1 to m3 m−3 ).
• Change all lake temperatures >300 K to 285 K as lake temperatures in COSMO are unrealistically
high.
./ungrid/src/rd_grib1.f90
• line 397 was edited and the variables map%dx and map%dy were hard-coded to be equal to the resolution
of the incoming COSMO data in the units of degrees.
• The resolution of the incoming COSMO data is set in the field extra script - in the present case it is
0.02° and thus map%dx = 0.02 and map%dy = 0.02.

4.2

Problem with Morrison microphysics in WRF version 3.7.1

Running the Morrison microphysics scheme without cumulus scheme in WRF version 3.7.1 requires
some adaptation, as described in http://www2.mmm.ucar.edu/wrf/users/wrfv3.7/known-prob-3.7.1.html
(accessed 18 August 2017).
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Problem with Morrison Scheme (posted January 15, 2016,
http://www2.mmm.ucar.edu/wrf/users/wrfv3.7/known-prob-3.7.1.html)
´´Problem: When using the Morrison scheme without any cumulus turned on in any of the
domains (for example, running a single domain with Morrison scheme only), problems exist because
the Morrison scheme uses some tendency arrays from output with a cumulus scheme. However,
these arrays were not allocated when no cumulus scheme is used.
Solution: If you wish to use this scheme without any cumulus, you must edit Registry.
EM_COMMON, and update this line, from:
package morr_two_moment mp_physics ==10 - moist :qv ,qc ,qr ,qi ,qs ,qg;
scalar :qni ,qns ,qnr ,qng
to
package morr_two_moment mp_physics ==10 - moist :qv ,qc ,qr ,qi ,qs ,qg;
scalar :qni ,qns ,qnr ,qng; state :rqrcuten ,rqscuten , rqicuten
Once you update the file, save the file, and then you will need to go back to the WRFV3/ directory,
issue a clean -a, then reconfigure, and recompile the code.”

5

Running WPS

To create meteorological and geographic input on a user defined grid, three pre-processing steps need to be
performed prior to running WRF. geogrid interpolates the geographic (static) data, i.e. topography, landuse,
soil type etc. to the chosen horizontal grid for the parent domain and all nests. ungrib reads meteorological
data given in grib1 or grib2 format. Finally, metgrid horizontally interpolates the meteorological data to
the horizontal grid produced by geogrid. Vertical interpolation will be done by the program real, which
is the last pre-processing step but part of WRF (see Section 6). General information about WPS and WRF
namelist settings are based on Wang et al. (2016).

5.1

Geogrid

To run geogrid.exe static data must be available in the /geog/ folder (Section 3) and the index file in the
/geog/ folder must be adapted for the desired domain. In the namelist.wps the &share and &geogrid
section must be specified. An example of namelist.wps is given in Appendix A.3. Suggestions and
information about some namelist options are listed in Table 2.
GEOGRID.TBL (in /WPS/geogrid/) For geogrid.exe to be able to read the static data provided in the
newly created folders for topo, landuse and soiltype, in /geog/ the GEOGRID.TBL file needs to be adapted.
• Add interp_option and rel_path for all static data (HGT_M, HGT_U, HGT_V, LANDUSEF, SOILCTOP,
and SOILCBOT).
• Change the default path to the new folder.
• For LANDUSEF additionally add line land_mask_water.
Terrain smoothing For complex topography and very high resolution simulations maximum slope angles
are likely very high. Large slope angles are critical for simulations with eta-coordinates, as too steep slopes
may cause problems when calculating the pressure gradient, as height differences between neighboring grid
points may become up to an order of magnitude larger than the elevation difference between neighboring
eta levels (Doyle et al., 2013). Therefore, it is recommended to apply a terrain smoothing to keep all
slope angles below 45°. For the simulations in Gerber et al. (2018) a minimum number of four smoothing
cycles with WPS 1-2-1 smoothing is needed. WPS 1-2-1 smoothing applies a moving window filter with a
window length of 3. Grid points i-1, i, and i+1 are weighted with a ratio of 1:2:1. However, a very small
simulation timestep is needed for a simulation with maximum slope angles of 45° (see Section 6). To speed
up simulations a stronger smoothing may be applied. To check maximum slopes in the geo_em.d*.nc files

Running WPS

10

see_slopes.ncl may be used. The smoothing type and the number of smoothing cycles need to be chosen
in GEOGRID.TBL:
• Chose smoothing type (smooth_option) and number of smoothing cycles (smooth_passes) in
GEOGRID.TBL.
Table 2: Description and suggestions for some options in namelist.wps. An example of namelist.wps can be found
in Appendix A.3.

Section

Option

Description

&geogrid

Parent_grid_ratio

An odd parent grid ratio is recommended because
the WRF grids are Arakawa C-staggered and therefore mass and velocity points of the parent and nest
will be coincident. A ratio of 1:3 is recommended
as it is most tested (Skamarock et al., 2008; Gill
and Pyle, 2010).

e_we/e_sn

For nested domains the ending point of the domain
in west-east (we) and south-north (sn) direction
must be chosen ”one greater than some integer
multiple of the nesting ratio“ (Wang et al., 2016),
to make sure that the upper right corner coincides
with a grid point of the parent domain.
e_we and e_sn must be chosen such that they
are inside the domain available for topography,
landuse and soiltype, but not too far from the
boundary, such that the smooth transition between
COSMO and the high resolution topography is inside the domain (Figure 1).

geog_data_res

Give the name of your newly created folder in /
geog/, which contains your topography binaries.

dx, dy

dx and dy are given in meters except when using
’lat-lon’ projection, where dx and dy are given
in degrees.

map_proj

For mid-latitude domains ’lambert’ projection is
most accurate. However, the output will not be on
regular output coordinates. For some applications
’mercator’ projection may thus be preferred.

ref_lat/ref_lon

Specifies the lower left corner (ref_x = 1, ref_y
= 1) of the parent domain and must be chosen
such that it is inside the domain provided by static
data but not too far from the edge such that the
transitional topography is inside the domain.

geog_data_path

Path of the /geog/ folder.

fg_name

Should correspond to the prefix in &ungrib, except if the intermediate files from ungrib were
moved to a different directory.

%opt_output_from_
metgrid_path

A path for met_em.d*.nc files may be specified.

Opt_output_from_
geogrid_path

A path for the output files geo_emd0*.nc can be
specified.

&metgrid

&share

Run geogrid: > ./geogrid.exe

Running WPS
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Ungrib

To run ungrib on COSMO-2 data all the steps described in Section 2 need to be performed in advance. As
COSMO-2 is not a standard input for WRF, a variable table translating COSMO-2 grib codes is required
and needs to be linked to WPS/Vtable (Vtable.COSMO.mixing.landuse, see Appendix A.2).
Run ungrib:
> ./ link_grib .csh <path_to_COSMO_files >/ laf # (no * to add all files )
> ./ ungrib .exe

5.3

Metgrid

Once geogrid.exe and ungrib.exe were run successfully, metgrid.exe can be run. Sections &geogrid
and &ungrib should be left unchanged. Section &share should stay unchanged except for start_date
and end_date for the nested domains, for which the start and the end date can be set to the start date and
time for the nests. For the nests only the start date and time needs to be processed, because the nests are
only initialized with COSMO input but boundary conditions will always be taken from the parent domain.
METGRID.TBL (in /WPS/metgrid/) When running a simulation with a land surface model, METGRID.TBL
needs to be adapted such that metgrid is able to read soil temperatures and soil moisture. For name=ST and
name=SM the new soil levels need to be added as conditional statement:
========================================
name=ST
...
# ELSE IF
fill_lev =
1 : T_SO0001 (200100)
fill_lev =
3 : T_SO0002 (200100)
fill_lev =
9 : T_SO0006 (200100)
fill_lev =
27 : T_SO0018 (200100)
fill_lev =
81 : T_SO0054 (200100)
fill_lev = 243 : T_SO0162 (200100)
========================================
name=SM
...
# ELSE IF
fill_lev =
1 : W_SO0001 (200100)
fill_lev =
3 : W_SO0002 (200100)
fill_lev =
9 : W_SO0006 (200100)
fill_lev =
27 : W_SO0018 (200100)
fill_lev =
81 : W_SO0054 (200100)
fill_lev = 243 : W_SO0162 (200100)
========================================
Additionally, for each soil level a block specifying soil temperature and soil moisture properties needs
to be added:
========================================
name= T_SO0000
interp_option = sixteen_pt + four_pt + wt_average_4pt + wt_average_16pt
+ search
masked = water
interp_mask = LANDSEA (0)
missing_value = -1. E30
fill_missing =285.
flag_in_output = FLAG_T_SO0000
========================================
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name= W_SO0001
interp_option = sixteen_pt + four_pt + wt_average_4pt + wt_average_16pt
+ search
masked = water
interp_mask = LANDSEA (0)
missing_value = -1. E30
fill_missing =1.
flag_in_output = FLAG_W_SO0001
========================================
Run metgrid:
> ./ metgrid .exe
Semi-idealized simulations for sensitivity studies
Option 1 To perform simulation over real complex topography but with constant meteorological
input, one possibility is to use a certain meteorological field from COSMO-2 and repeatedly feed it
to WRF as boundary condition. A test has been run but no thorough analysis has been performed. To
make a certain meteorological condition available for every boundary input timestep, met_em.d*.nc
files can be multiplicated and the timestamp of the files may be adapted. To adapt the timestamp
in the multiplicated .nc-files change_Times_netcdf.ncl is available. However, before using this
approach the following short-comings should be addressed:
• Are the chosen atmospheric conditions representative?
• Are the chosen nighttime/daytime conditions problematic when repeated for day/night times?
Option 2 Another option to address the sensitivity of precipitation to different wind speeds has
been performed in Gerber et al. (in prep.). For this analysis wind speeds have been reduced to one
third or two thirds of the original wind speeds, while all other variables were left unchanged for a
given event. To adapt wind speeds in the met_em*.nc files change_wind_netcdf.ncl is available.

6

Running WRF

Setting up a very-high resolution simulation over complex terrain for snow covered conditions is challenging.
Different settings and changes to standard settings are needed to run COSMO-WRF simulations. Below, the
settings used for simulations presented in Gerber et al. (2018) are mentioned and described. An example of
namelist.input is given in Appendix A.4.
Vertical nesting in version 3.7.1 As vertical nesting (Daniels et al., 2016) is not fully implemented in
version 3.7.1, the eta_levels have to be determined manually. The simplest procedure to do this is to run a
very short simulation for each number of vertical levels on a single domain.
Note
This issue has been fixed in newer versions of WRF (Megan Daniels, personal communication).
• Choose vertical levels
• For each domain, i.e. for all different numbers of vertical levels:
– Run a very short simulation (2 s, setting history_interval_s = 1) on only one domain with
the chosen number of vertical levels.
– Use ncdump -v ZNW wrfout_d01_<DATE> > dumpETA.txt
– Copy and paste the ZNW (eta levels) into the namelist.input

Running WRF
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Additional refinement of vertical levels on 50 meter resolution A refinement of vertical levels in the
boundary layer was performed to get a higher resolution of close-ground processes in very-high resolution
simulations. The refinement is performed as suggested in a WRF tutorial about real by Gill (2015). For
the refinement 10 additional eta-levels are added to the boundary layer.
Large Eddy Simulations (LES) To run WRF simulation in the LES mode different settings are required. Generally, the LES mode of WRF is based on choosing no boundary layer parametrization
(bl_pbl_physics = 0). Depending if the simulation is run with or without a land surface model, different
additional settings need to be chosen (Dudhia, 2012). The use of the LES mode is basically recommended
for simulation with dx 1 km. Recommended namelist settings for complex topography and high resolution
simulations are given in (Dudhia, 2012).
Settings chosen for simulations in Gerber et al. (2018) are based on Dudhia (2012):
diff_opt = 2
isfflx = 1 # drag and heat flux from physics
sf_sfclay_physics = 1
sf_surface_physics , 0
km_opt = 2 # or 3
mix_isotropic = 0 # set to 1 for dx ≈ dz
gwd_opt = 0
Alternatively, the following may be chosen:
isfflx = 2 # drag from physics , heat flux from tke_heat_flux
sf_sfclay_physics = 1
Note
mix_isotropic has been set to 0 for all simulation domains for the simulation in Gerber et al.
(2018). It might be valuable to change mix_isotropic to 1 for the two innermost domains with
resolutions of 150 m and 50 m, respectively.

Mesoscale setting Given the setup with resolutions of 1350 m, 450 m, 150 m, and 50 m in the parent
domain and the three nests, a mesoscale setting is appropriate for the parent domain with a grid size of
1350 m. For mesoscale simulations a planetary boundary layer (PBL) scheme (bl_pbl_pyhsics) has to
be chosen. For complex terrain the Yonsei University (YSU) PBL scheme (Hong et al., 2006) was found
to be one of the best schemes for simulations over complex terrain (Gómez-Navarro et al., 2015). A more
sophisticated version of YSU PBL is available, which takes into account subgrid scale orography (Jiménez
and Dudhia, 2012). This is claimed to correct for negative (positive) wind speed biases over mountainous
(flat) terrain (Jiménez and Dudhia, 2012; Lee et al., 2015). Comparing the influence of a parent domain
with and without corrections for subgrid scale orography would be very interesting. To keep the simulation
setup simple, simulations in Gerber et al. (2018) were run with the uncorrected YSU PBL scheme for the
parent domain.
Note on model resolutions
In numerical modeling different zones are distinguished. Large-scale and mesoscale simulations are
commonly used for simulations with horizontal resolutions of >10 km. For these coarse resolutions
no turbulence is resolved and a boundary layer parameterization is needed. At small scales (< few
100 m) large eddy simulations (LES) are used, which allow to resolve all major eddies. The zone in
between is usually referred to as the “grey zone” or “terra incognita” (Wyngaard, 2004). This is the
zone where a certain part of turbulent kinetic energy is resolved but not all. The “grey zone” is most
challenging in numerical simulations. Approaches have been proposed to skip the “grey zone” by
choosing the grid ratio accordingly (Rai et al., 2017).
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Roughness length of snow in complex terrain Snow cover is often assumed to have a very low roughness
length, which is good for relatively flat and gentle terrain. However, snow cover in alpine terrain is likely
rough due to large rocks and the complex topography, which is only partially smoothed out by the snow
cover. Therefore, for simulations over snow in complex terrain, we suggest to increase the roughness length
of snow to 0.2 m instead of the default value of 0.002 m, as the size of roughness elements of 2 m seems
to be reasonable to account for missing terrain features and roughness due to large rocks in snow covered
complex terrain. Roughness was determined by the comparison of a 2 m digital terrain model (DTM-AV
© 2018 swisstopo (5704 000 000)) with a 25 m digital elevation model (dhm25 © 2018 swisstopo (5740
000 000)). To evaluate the roughness of complex alpine terrain, the average of the absolute difference of
the two terrain models for a domain covering the upper Dischma valley (Davos, Switzerland, innermost
domain in simulations by Gerber et al. (2018) between 2200 and 2700 meter above sea level has been taken.
The average difference is 2.5 m. To account for smoothing due to snow coverage, we estimate the size of
roughness elements to 2 m.
Depending on the chosen surface model, different tables need to be adjusted to change the roughness
length properties. When using sf_surface_physics = 4 (see next paragraph) the file MPTABLE.TBL is
used. In MPTABLE.TBL the roughness length of snow is specified as Z0SNO. We suggest changing Z0SNO
from 0.002 m to 0.2 m.
Land-surface model The most common land surface model in WRF is the Noah land surface model
(Tewari et al., 2004). However, this model has been further developed and a more recent version Noah
with multiple parametrization (Noah-MP Niu et al., 2011; Yang et al., 2011) is available. Noah-MP has a
more sophisticated treatment of snow. Therefore, COSMO-WRF in Gerber et al. (2018) is run with NoahMP surface physics (sf_surface_physics = 4). When running a simulation with a surface model, the
number of input soil layers (num_metgrid_soil_levels), the input source (surface_input_source),
the number of soil levels in WRF (num_soil_layers), and the number of land categories (num_land_cat)
have to be specified. For sf_surface_physics = 4 the parameter ifsnow is irrelevant as it is only used
for sf_surface_physics = 1 (Wang et al., 2016).
Simulation timestep The simulation timestep is strongly dependent on the steepness and complexity of
the topography and may therefore differ for different domains. Based on the timestep requirements of
simulations over complex terrain in the surroundings of Davos (Switzerland, Gerber et al., 2018), with
maximum slope angles of 45° at a 50 m resolution (simulation set up with parent domain and three nest with
horizontal resolutions of 1350 m, 450 m, 150 m, and 50 m and 40, 40, 60, and 90 vertical levels and a model
top at 150 mbar) we recommend to start with:
timestep = 1 # second
parent_time_step_ratio = 1,3,3,3,
For a simulation with the same simulation setup but stronger terrain smoothing (maximum slope angles
for 50 m resolution of 37.4°), the following setup is recommended to start with:
timestep = 6 # seconds
parent_time_step_ratio = 1,3,4,2,
Note
Time steps should always be chosen such that they end up to round numbers to avoid stability
problems in the model (M. Daniels, personal communication).

Horizontal resolution and domain The specifications for horizontal resolution and the domain have to
be set corresponding to the settings chosen in WPS (Section 5).
Radiation The simplest schemes are chosen for radiation. slope_radiation and topo_shading make
sure shadows due to topography in complex terrain are properly simulated. The radiative time step radt is
5 min. Based on the WRF User Guide it is recommended to choose radt as “1 min per km of dx” (Wang
et al., 2016). However, calculating radiation more frequently than every 5 min to 15 min is not necessary as
radiation is not a quickly changing process. The parameter icloud allows for cloud effects on radiation.
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Precipitation The microphysics scheme (mp_physics) is set to the Morrison 2-moment scheme (Morrison
et al., 2005; Morrison et al., 2009). The Morrison 2-moment scheme (option 10) and the Thompson graupel
scheme (option 8) have been found to most properly simulate solid precipitation in complex terrain (Liu
et al., 2011). The cumulus parameterization (cu_physics) is set to zero, as it is recommended to run
simulations without a cumulus parameterization for grid sizes <4 km (e.g. Wang, 2015).
Run a simulation Prior to running wrf.exe, the input data has to be interpolated to the chosen vertical
levels by real.exe. Namelist setting in namelist.input for real.exe and wrf.exe are identical
(Appendix A.3 and Appendix A.4). Once all settings in the namelist.input are chosen, real.exe can
be run and if successful, wrf.exe can be run.
To restart a simulation the namelist.input has to be adapted:
• Change run_days, run_hours, run_minutes and run_seconds to the remaining time.
• Change start_year, start_month, start_day, start_hour, start_minute and start_second
to the date and time of the last available restart file. The frequency of restart files can be determined
by restart_interval.
• Change restart to .true. if it is the first restart.
• Restart the simulation.
Running a simulation on Piz Daint at CSCS
To run a simulation a batch job needs to be submitted. Therefore, batch scripts are required for
both, to run real and wrf (real.job and wrf.job). On Piz Daint, any simulation can run over a
maximum of 24 h. Therefore, longer WRF simulations need to be restarted every 24 h. To run the
simulation, the batch script has to be submitted:
> sbatch WRF_real .job
To check the status of the simulation:
> squeue -u $USER
Output from the simulation is written to rsl.out.0000. When real.exe was successful SUCCESS
COMPLETE REAL_EM INIT will be written at the end of rsl.out.0000. Note: rsl.out.* and
rsl.error.* files are written for each cpu.
When real is successful, wrf.exe can be run:
> sbatch WRF_wrf .job
To restart the simulation, the namelist.input needs to be adapted and another batch job needs to
be submitted.

7

Post processing

Different post-processing methods will be described. The list does not cover all aspects of post-processing
that may be valuable for any kind of analysis. However, we provide some post-processing information for
more complex analysis.

7.1

Map WRF output on Swiss Coordinates

For comparison to e.g. operational radar data by MeteoSwiss, it is helpful to display the same domain as the
radar. However, radar data comes in Swiss Coordinates (CH1903LV03). This requires mapping of WRF
output on the Swiss Coordinate system and plot it in the Swiss Coordinate reference frame.
• create the required lat/lon coordinate grid in swiss coordinates (CH1903LV03)
→ create_CH1903LV03_vector.py
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• remap the created ascii-file into global coordinates (ETRF93/CHTRF95 (ETRS89/CHTRS95/ WGS84)
using the REFRAME tool by swisstopo (https://www.swisstopo.admin.ch/de/karten-daten-online/calculation-services/
reframe.html, accessed: 22 August 2017)
• interpolate the WRF data onto the new global coordinates, which correspond to the swiss coordinates
and plot them in the reference frame of swiss coordinates
→ plane_2dfield_snowacc24h_everyoutputtime_raddom.py

7.2

Precipitation rate at horizontal level

Precipitation rate (RAINNC: total precipitation, SNOWNC: solid precipitation without graupel and GRAUPELNC: graupel only) in WRF is only given as a ground level output. To analyze precipitation fields with
respect to radar precipitation fields, WRF precipitation needs to be extracted at the radar elevation level.
Given the particle size distribution N(D)
N(D) = N0 Dµ e−λD,

(1)

where D is the particle diameter, N0 is the intercept, λ the slope and µ the shape parameter of the size
distribution, precipitation rate (Ri ) can be calculated from the predicted mixing ratios (qi ) and the predicted
number concentration (Ni ) of hydrometeors (i) as:
∫ ∞
vi (D)mi (D)Ni (D)dD
(2)
Ri =
0

αDβ

with terminal fall velocity v(D) =
and mass m(D) = aD b , where D is the particle diameter and α,
β, a, and b are constants (Table 3). Integration of Ri results in:
Ri = N0,i ai αi
with

Γ(bi + βi + 1 + µi )

ai Γ(µi + bi + 1)
λi =
qi Γ(µi + 1)


and

(3)

(bi +βi +1+µi )

λi



(4)

(µ +1)

N0,i =

Ni λi i
Γ (µi + 1)

(5)

Due to the terrain-following vertical coordinates all WRF parameters need to be interpolated to the radar
elevation, which is done by inverse-weighted interpolation between the two closest eta-levels to the required
elevation.
Note
The precision of the output fields strongly depends on the output-timestep. Strong differences
between e.g. SNOWNC and calculated precipitation at the ground level may arise with an output
timestep of 30 minutes, as WRF updates summed precipitation every simulation timestep.
Table 3: Constants for precipitation rate calculation for the ice, snow and graupel hydrometeors. ρ is the density of the
different hydrometers. a and b are the constants for the mass and α and β are the constants for the terminal fall velocity
equation. µ is the shape parameter of the particle size distribution. Values for graupel are given for simulations run
without hail (i.e. option IHAIL = 0).

Hydrometeor
Ice
Snow
Graupel

ρ
500
100
400

a

b

α

β

µ

ρice π6
ρsnow π6
ρgraupel π6

3
3
3

700.00
11.72
19.30

1.00
0.41
0.37

0
0
0
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Requirements

Software
• fieldextra (available on CSCS, owned by MeteoSwiss: /users/oprusers/osm/opr/abs/fieldextra
, location may change)
• WRF version 3.7.1 (including WPS, http://www2.mmm.ucar.edu/wrf/users/download/get_source.
html, accessed: 14 March 2018)
• python
• gfortran
• NCL
• GIS software (e.g. ArcGIS)

Data
• COSMO-2 reanalysis (available on CSCS, owned by MeteoSwiss: /store/archive/mch/msopr/
owm/COSMO/LA<YEAR>/<DATE>.tar)
• Aster topography: https://gdex.cr.usgs.gov/gdex/ (accessed: 18 August 2017)
• Corine landuse: https://www.eea.europa.eu/data-and-maps/data/clc-2006-raster (downloaded: 15
June 2016, accessed: 18 August 2017, new version available)

Pre-preprocessing scripts
Meteorological data
•
•
•
•
•
•
•
•
•
•

cosmo_untar.sh
create_list.sh
2Ddata.nl
3Ddata.nl
rot_vel_from_raw_for_WRFinput.py
rot_vel_from_raw_for_WRFinput.job (if running as batch job)
change_vals_day.bash
change_vals_day_soil.bash
change_Times_netcdf.ncl
change_wind_netcdf.ncl

Static data
•
•
•
•
•
•
•
•
•
•

(MeteorologicalData.zip)

(StaticData.zip)

toposmoothtest_wgs84_cosmobound.ncl
soiltype_writing.py
write_geogrid.o
ascii_to_bin_topo_wgs84_ws2sf1.f90
ascii_to_bin_topo_wgs84_ws2sf1.exe
ascii_to_bin_landuse.f90
ascii_to_bin_landuse.exe
ascii_to_bin_soiltype.f90
ascii_to_bin_soiltype.exe
see_slopes.ncl

Adapted Files to compile WPS/WRF
WPS

(WPSSetup.zip)

• rrpr.f90-soilmoistandtempadapted
• rd_grib1.f90-COSMO
• Corrections for WRF3.7.1 when using Morrison microphysics: http://www2.mmm.ucar.edu/wrf/
users/wrfv3.7/known-prob-3.7.1.html (accessed 18 August 2017)
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Files to run WPS/WRF
WPS
•
•
•
•
•
•
•

(WPSrun.zip)
index_topo
index_landuse
index_soiltype
GEOGRID.TBL-aster-121_4 (example with four smoothing cycles of 1-2-1 smoothing)
METGRID.TBL-T_SOfill285-W_SOfill1
namelist.wps
Vtable.COSMO.mixing.soil

Note
index files need to be named index in their respective folder (Section 3).

WRF
•
•
•
•

(WRFrun.zip)
MPTABLE.TBL_Z0SNO0.2
namelist.input
WRF_real.job
WRF_wrf.job

Postprocessing
Map WRF output on Swiss Coordinates

(Postprocessing.zip)

• Coordinate transformation swiss coordinates to global coordinates for whole grid: https://www.
swisstopo.admin.ch/de/karten-daten-online/calculation-services/reframe.html (accessed: 22 August
2017)
• create_CH1903LV03_vector.py
• create_arcgis_ascii.py
• read_wrffields.py
Precipitation rate at horizontal level

Python scripts may be made available upon request.

Vtable for COSMO-2 data

A.2

Vtable for COSMO-2 data

+------+-------+-------+-------+-----------+-----------+-----------------------------------------+
|GRIB | Level | Level | Level | metgrid
| metgrid | METGRID
|
|Code | Code |
1
|
2
| Name
| Units
| Description
|
+------+-------+-------+-------+-----------+-----------+-----------------------------------------+
|
6 | 100
|
*
|
| GEOPT
| m2 s -2
|
|
|
| 100
|
*
|
| HGT
| m
| Height
|
| 11 | 100
|
*
|
| TT
| K
| Temperature
|
| 33 | 100
|
*
|
| UU
| m s -1
| U
|
| 34 | 100
|
*
|
| VV
| m s -1
| V
|
| 52 | 100
|
*
|
| RH
| %
| Relative Humidity
|
| 11 |
1
|
0
|
| SKINTEMP | K
| Skin temperature (can use for SST also) |
| 11 | 105
|
2
|
| TT
| K
| Temperature
at 2 m
|
| 52 | 105
|
2
|
| RH
| %
| Relative Humidity at 2 m
|
| 33 | 105
| 10
|
| UU
| m s -1
| U
at 10 m
|
| 34 | 105
| 10
|
| VV
| m s -1
| V
at 10 m
|
|
1 |
1
|
0
|
| PSFC
| Pa
| Surface Pressure
|
|
2 | 102
|
0
|
| PMSL
| Pa
| Sea - level Pressure
|
| 66 | 1
|
0
|
| SNOWH
| m
| Physical Snow Depth
|
| 31 | 100
|
*
|
| QC
| kg kg -1
| Cloud water mixing ratio
|
| 36 | 100
|
*
|
| QS
| kg kg -1
| Snow water mixing ratio
|
| 39 | 100
|
*
|
| QG
| kg kg -1
| Graupel water mixing ratio
|
| 35 | 100
|
*
|
| QR
| kg kg -1
| Rain water mixing ratio
|
| 178 | 100
|
*
|
| QI
| kg kg -1
| Ice mixing ratio
|
| 85 | 112
|
0
|
1 | T_SO0001 | K
| Soil temperature 1 cm below ground
|
| 85 | 112
|
1
|
3 | T_SO0002 | K
| Soil temperature 2 cm below ground
|
| 85 | 112
|
3
|
9 | T_SO0006 | K
| Soil temperature 6 cm below ground
|
| 85 | 112
|
9
|
27 | T_SO0018 | K
| Soil temperature 18 cm below ground
|
| 85 | 112
| 27
|
81 | T_SO0054 | K
| Soil temperature 54 cm below ground
|
| 85 | 112
| 81
| 243 | T_SO0162 | K
| Soil temperature 162 cm below ground
|
| 86 | 112
|
0
|
1 | W_SO0001 | m
| Soil moisture 1 cm below ground
|
| 86 | 112
|
1
|
3 | W_SO0002 | m
| Soil moisture 2 cm below ground
|
| 86 | 112
|
3
|
9 | W_SO0006 | m
| Soil moisture 6 cm below ground
|
| 86 | 112
|
9
|
27 | W_SO0018 | m
| Soil moisture 18 cm below ground
|
| 86 | 112
| 27
|
81 | W_SO0054 | m
| Soil moisture 54 cm below ground
|
| 86 | 112
| 81
| 243 | W_SO0162 | m
| Soil moisture 162 cm below ground
|
+------+-------+-------+-------+-----------+-----------+-----------------------------------------+
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namelist.wps
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namelist.wps

& share
wrf_core
= ’ARW ’,
max_dom
= 1,
start_date
= ’2016 -01 -29 _05 :00:00 ’ , ’2016 -01 -30 _05 :00:00 ’ , ’2016 -01 -30
_17 :00:00 ’ , ’2016 -01 -30 _23 :00:00 ’ ,
end_date
= ’2016 -02 -01 _00 :00:00 ’ , ’2016 -01 -30 _05 :00:00 ’ , ’2016 -01 -30
_17 :00:00 ’ , ’2016 -01 -30 _23 :00:00 ’ ,
interval_seconds = 3600 ,
io_form_geogrid = 2,
opt_output_from_geogrid_path = ’/ project /s569/ gerberf / input_WPS / GEO_EM /’
/
& geogrid
parent_id
parent_grid_ratio
i_parent_start
j_parent_start
e_we
e_sn
geog_data_res
dx
dy
map_proj
ref_lat
ref_lon
ref_x
ref_y
truelat1
truelat2
stand_lon
geog_data_path
/

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

1, 1, 2, 3,
1, 3, 3, 3,
1, 105, 83, 88,
1, 82, 54, 55,
184, 202, 199, 199,
237, 199, 199, 199,
’topo_1s ’, ’topo_1s ’,’topo_1s ’,’topo_1s ’,
1350 ,
1350 ,
’lambert ’,
45.4 ,
7.4,
1,
1,
46.4 ,
47.2 ,
9.0,
’/ project /s569/ gerberf / geog_origWRF ’

& ungrib
out_format
= ’WPS ’,
prefix
= ’/ project /s569/ gerberf / input_WPS /FILES/COSMO_Jan Mar_landsurf_ptop100 /FILE ’,
/
& metgrid
fg_name
= ’/ project /s569/ gerberf / input_WPS /FILES/COSMO_Jan Mar_landsurf_ptop100 /FILE ’
io_form_metgrid
= 2,
opt_output_from_metgrid_path = ’/ project /s569/ gerberf / input_WRF / METFILES /
COSMO_Jan - Mar_smoothboundaries1440_cosmo -le -360
_mixing_1350_lambert_landuse_wrfsmooth14_ptop100 /’
/

namelist.input
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namelist.input

& time_control
run_days
run_hours
run_minutes
run_seconds
start_year
start_month
start_day
start_hour
start_minute
start_second
end_year
end_month
end_day
end_hour
end_minute
end_second
interval_seconds
input_from_file
fine_input_stream
history_interval
frames_per_outfile
restart
restart_interval
write_hist_at_0h_rst
io_form_history
io_form_restart
io_form_input
io_form_boundary
io_form_auxinput2
debug_level
/

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

2,
19,
0,
0,
2016 , 2016 , 2016 , 2016 ,
01, 01, 01, 01,
29, 30, 30, 30,
05, 05, 17, 23,
00, 00, 00, 00,
00, 00, 00, 00,
2016 , 2016 , 2016 , 2016
02, 02, 02, 02,
01, 01, 01, 01,
00, 00, 00, 00,
00, 00, 00, 00,
00, 00, 00, 00,
3600 ,
.true., .true .,. true .,. true.,
0, 2, 2, 2,
30 ,30 ,30 ,30 ,
48, 48, 48, 48,
. false.,
60,
.true.
2,
2,
2,
2,
2,
0,

& domains
time_step
= 1,
time_step_fract_num
= 0,
time_step_fract_den
= 1,
max_dom
= 4,
e_we
= 184, 202, 199, 199,
e_sn
= 237, 199, 199, 199
e_vert
= 40, 40, 60, 90,
vert_refine_method
= 0,2,2,2,
eta_levels
= 1, 0.993 , 0.983 , 0.97 , 0.954 , 0.934 , 0.909 ,
0.88 , 0.8600174 , 0.840035 , 0.8200524 , 0.8000699 , 0.761449 , 0.7237018 ,
0.6868118 , 0.6507629 , 0.615539 , 0.5811244 , 0.5475038 , 0.5146619 ,
0.4825837 , 0.4512546 , 0.42066 , 0.3907857 , 0.3616177 , 0.3331423 , 0.3053457 ,
0.2782149 , 0.2517365 , 0.2258978 , 0.200686 , 0.1760886 , 0.1520934 ,
0.1286884 , 0.1058616 , 0.08360139 , 0.06189632 , 0.0407351 , 0.02010664 , 0,
1, 0.993 , 0.983 , 0.97 , 0.954 , 0.934 , 0.909 , 0.88 , 0.8600174 , 0.840035 ,
0.8200524 , 0.8000699 , 0.761449 , 0.7237018 , 0.6868118 , 0.6507629 , 0.615539 ,
0.5811244 , 0.5475038 , 0.5146619 , 0.4825837 , 0.4512546 , 0.42066 ,
0.3907857 , 0.3616177 , 0.3331423 , 0.3053457 , 0.2782149 , 0.2517365 ,
0.2258978 , 0.200686 , 0.1760886 , 0.1520934 , 0.1286884 , 0.1058616 ,
0.08360139 , 0.06189632 , 0.0407351 , 0.02010664 , 0,
1, 0.993 , 0.983 , 0.97 , 0.954 , 0.934 , 0.909 , 0.88 , 0.8679016 , 0.8558034 ,
0.8437051 , 0.8316067 , 0.8079001 , 0.7845152 , 0.7614485 , 0.7386963 ,
0.7162551 , 0.6941214 , 0.6722915 , 0.6507621 , 0.6295298 , 0.608591 ,
0.5879425 , 0.5675809 , 0.5475029 , 0.5277053 , 0.5081847 , 0.488938 , 0.469962 ,
0.4512536 , 0.4328096 , 0.4146269 , 0.3967026 , 0.3790335 , 0.3616167 ,

namelist.input

23

0.3444492 , 0.3275281 , 0.3108504 , 0.2944133 , 0.2782139 , 0.2622495 ,
0.2465171 , 0.2310141 , 0.2157377 , 0.2006852 , 0.1858538 , 0.1712411 ,
0.1568442 , 0.1426606 , 0.1286878 , 0.1149231 , 0.1013641 , 0.08800822 ,
0.074853 , 0.06189599 , 0.04913476 , 0.03656691 , 0.02419006 , 0.01200187 , 0,
1, 0.999 , 0.998 , 0.996 , 0.994 , 0.992 , 0.990 , 0.980 , 0.970 , 0.960 , 0.950 , 0.940 ,
0.930 , 0.920 , 0.910 , 0.900 , 0.890 , 0.880 , 0.8713248 , 0.8626496 , 0.8539743 ,
0.8452992 , 0.8282002 , 0.8112669 , 0.7944981 , 0.7778924 , 0.7614484 ,
0.745165 , 0.7290407 , 0.7130743 , 0.6972646 , 0.68161 , 0.6661096 , 0.650762 ,
0.6355659 , 0.6205201 , 0.6056233 , 0.5908744 , 0.5762722 , 0.5618153 ,
0.5475027 , 0.5333331 , 0.5193053 , 0.5054182 , 0.4916706 , 0.4780613 ,
0.4645893 , 0.4512533 , 0.4380522 , 0.4249849 , 0.4120502 , 0.3992472 ,
0.3865746 , 0.3740314 , 0.3616164 , 0.3493286 , 0.337167 , 0.3251304 , 0.3132178 ,
0.3014282 , 0.2897605 , 0.2782136 , 0.2667867 , 0.2554785 , 0.2442882 ,
0.2332146 , 0.2222569 , 0.211414 , 0.2006849 , 0.1900687 , 0.1795644 , 0.169171 ,
0.1588876 , 0.1487132 , 0.1386468 , 0.1286876 , 0.1188346 , 0.1090869 ,
0.09944359 , 0.08990372 , 0.0804664 , 0.07113075 , 0.06189587 , 0.05276088 ,
0.04372491 , 0.03478707 , 0.02594652 , 0.01720238 , 0.008553809 , 0,
p_top_requested
= 15000 ,
num_metgrid_levels
= 39,
num_metgrid_soil_levels
= 6,
dx
= 1350 , 450, 150, 50,
dy
= 1350 , 450, 150, 50,
grid_id
= 1, 2, 3, 4,
parent_id
= 1, 1, 2, 3,
i_parent_start
= 1, 105, 83, 88,
j_parent_start
= 1, 82, 54, 55,
parent_grid_ratio
= 1, 3, 3, 3,
parent_time_step_ratio
= 1, 3, 3, 3,
feedback
= 0,
smooth_option
= 0,
/
& physics
mp_physics
ra_lw_physics
ra_sw_physics
slope_rad
topo_shading
radt
sf_sfclay_physics
sf_surface_physics
bl_pbl_physics
bldt
cu_physics
cudt
isfflx
ifsnow
icloud
surface_input_source
num_soil_layers
num_land_cat
sf_urban_physics
/

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

10, 10, 10, 10,
1, 1, 1, 1,
1, 1, 1, 1,
1, 1, 1, 1,
1, 1, 1, 1,
5., 5., 5., 5.,
1, 1, 1, 1,
4, 4, 4, 4,
1, 0, 0, 0,
0, 0, 0, 0,
0, 0, 0, 0,
0, 0, 0, 0,
1,
1,
1,
1,
4,
24,
0, 0, 0, 0,

&fdda
/
& dynamics
rk_ord
diff_opt
km_opt

= 3,
= 2, 2, 2, 2,
= 2, 2, 2, 2,

namelist.input

diff_6th_opt
damp_opt
zdamp
dampcoef
w_damping
khdif
kvdif
non_hydrostatic
moist_adv_opt
scalar_adv_opt
epssm
/
& bdy_control
specified
spec_bdy_width
spec_zone
relax_zone
nested
/

24

=
=
=
=
=
=
=
=
=
=
=

0, 0, 0, 0,
3,
5000. , 5000. , 5000. , 5000. ,
0.2, 0.2, 0.2, 0.2,
0,
0, 0, 0, 0,
0, 0, 0, 0,
.true., .true .,. true .,. true.,
1, 1, 1, 1,
1, 1, 1, 1,
1, 1, 1, 1,

=
=
=
=
=

.true., . false .,. false .,. false.,
5,
1,
4,
. false., .true .,. true .,. true.,

& grib2
/
& namelist_quilt
nio_tasks_per_group
nio_groups
/

= 0,
= 1,
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